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1 Overview
GeoTide Analyzer carries out harmonic tidal constituent analysis, and is designed for
the professional hydrographer and tidal surveyor.  

GeoTide Analyzer converts observed tide gauge data directly into tidal harmonic
constants which can then be used to make tidal predictions for any future or past date. 

To create the tidal harmonic constants you need good quality tide gauge data. Your tide
gauge data is imported into the GeoTide system using the comprehensive data import
facilities, these facilities enable you to select the relevant data fields from the import file
data.  The import data can also be imported from a text editor or from a spreadsheet
such as Microsoft Excel.  

In certain rare cases, for example where the tide gauge output is in binary, we can
provide additional conversion routines.

Once imported, the tidal data can be edited and filtered using the comprehensive
facilities provided within GeoTide to remove spikes and erroneous points. 

The user can then select from various options which set  the number and type of
harmonic constants to be found. 

Advanced users can even create their own tidal scheme for use with GeoTide Analyzer,
specifying which tidal components to include. 

The analyzer provides analysis facilities for both tidal heights, and tidal streams.

The tidal constants files created by GeoTide Analyzer are compatible with
GeoTide-Predictor, our premier tidal prediction package which enables you to produce
document ready tide tables. 

You an also select a scheme which produces harmonic constants which are compatible
with the UKHO Simplified Method, UKHO TotalTide Program and the NOAA Tidal
Constituents set.

GeoTide Analyzer also incorporates a log of each processing action.

1.1 Facilities
 

Data Import. 
Supports comma delimited & fixed space ASCII formats. 

Graphical Data Editor.
Supports scroll, zoom, edit, delete, filter, average and resample. 

Tidal Harmonic Analysis
Converts tidal data into Doodson style harmonic constants. 

User-Selectable Tidal Schemes
Enables the user to choose from a number of sets of harmonic constituents, for
compatibility with UKHO Simplified, TotalTide and NOAA methods. 

Tide-tables
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Support for creating Tide Table via GeoTide Predictor.

Spectral Analysis
Frequency scanner for  identifying tidal harmonic components. 

Reporting Facility
Provides a computer generated report of the tidal levels and analysis statistics. 

Tidal Exceedance Tables
Generates 3 types of Tidal Exceedance Tables. 

Log
Comprehensive logging of actions for quality audit. 

1.2 Running
You can run GeoTide either by clicking the icon on the desktop, or by clicking the
program shortcut in the Start>Programs menu items, or from a file manager such as
Microsoft Windows Explorer.  Before starting the program please ensure that your
hardware security key (dongle) is inserted into a suitable USB port and has been
correctly installed.

        

GeoTide Analyzer first displays the screen below, during which time it allocates memory
and loads program modules. 

Click OK to display the screen below. This is the main operating window of GeoTide
Analyzer. 
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1.3 Panels

The main windows are listed below. 

Window Name Purpose 

GeoTide: Analyzer (Main Screen) Graphical display of a tidal record

Plot Controller Sets which plots are displayed.

Sampling Controls points sampling

Average Controls points averaging

Filter Automates the removal of rogue outlying data
points

Analysis Controls the analysis process

Graph Prediction Controls graph prediction & comparison

Import: Height Field selection & importing height

Import: 1D Stream Field selection & importing stream speed only

Import: 2D Stream Field selection & import of stream speed &
bearing 

Create 2D Stream Combining 1D location constants

Graphic Settings Sets the appearance of the graph points. 

GeoTide: Prism Spectral analysis of tidal source data

Report Creates a report of tidal parameters & prediction
accuracy.

1.4 Default Folders
In line with Microsoft Windows Guidance Notes GeoTide separates the application folder
from the user's data and configuration data. 

Upon installation GeoTide uses the %APPDATA% environment variable to determine the
user's roaming data folder. This folder is used as the default for file selection in the file
open and file save as dialogue boxes. Depending upon your system setup this GeoTide
folder normally appears in a similar way to that shown below. The folder GeoTide is used
as the default folder for most saving and loading operations.
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When harmonic constants have been produced (.tc1 files) the user should save the files
to the folder GeoTide  (located at:  %APPDATA%\GeoTide) or  to its sub-folder
TidalData ( i.e. located at %APPDATA%\GeoTide\TidalData) as shown below. 

User Data

Tidal Record Files (.rec)
Folder:  %APPDATA%\GeoTide

Analyzer Report Files (.rtf)
Folder: %APPDATA%\GeoTide

Harmonic Constants (.tc1)
Folder: %APPDATA%\GeoTide or %APPDATA%\GeoTide\TidalData

Note: Files within %APPDATA%\GeoTide\TidalData are automatically displayed by the
Predictor within its location display panel for ease of selection.

Configuration Data

The following locations are used to store configuration settings.

Analyzer Configuration Data (.cfg)
Initial Folder: %APPDATA%\Analyzer

Predictor Configuration Data (.cfg)
Initial Folder: %APPDATA%\Predictor
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1.5 Analysis and Prediction in 10 steps

Run Analyzer.EXE

1. Click and load example file by using File|Load "whitby.rec" 

2. Click Analyze|Select Scheme "Mixed Tide 1M-3M.sch"

3. Click Solve By: Matrix Inversion

4. Click Analyse. GeoTide displays RMSE 6.3mm

5. Click Close

6. Click File|Save location constants. The dialogue should prompt you with a name and

location. Click Save.

7 Click Exit on the main window to close the analyzer.

Run Predictor.exe

8. Click File | Open

9. Select  the .tc1 file which you just created above

10. It loads as Whitby Harbour and then draw the graph shown below.

Notes
You can drag the graph left or right or zoom in and out as you wish.
You can use the graph menu option to change the date and duration.

Congratulations - you have successfully carried out a harmonic tidal analysis and you
used the results to make predictions!
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1.6 Stages in
An overview of  the basic steps required for carrying out tidal analysis and prediction
are:-

· Importing
Use the File>Import>Height menu to import an ASCII tidal height file.  

·
· Saving

Use the File>Save menu to save a tidal data file.  
·
· Loading

Use the File>Load menu to load a data file which has previously been saved.  
·
· Editing

Optionally manually edit or filter the data points as required.  
·
· Analysing

Select the tidal scheme and then carry out the tidal analysis. 
·
· Predicting

Click the Predict menu option button. 

More details are provided on each step in the following pages.

1.6.1 Importing
To import a tidal record in ASCII format click the File>Import>Depth menu  to load and
select a tidal data file. Data files which have been created in a fixed space or comma
delimited ASCII file can be imported, provided there is one complete date and height on
each record. To import the data the following steps are required.

Steps

1.  You must first decide whether the source data is fixed space or delimited. 

Fixed space data appears in regular columns, whereas delimited data uses a
character, usually a comma or tab to separate the data fields. Click the radio
button to select the appropriate option for your data.

2. Selecting the data fields.

Click the button marked Date and highlight with the mouse the first occurrence of
the date field within the data as shown. 
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The date information is identified and copied to the first row under the label
headed "First Point Selected".

 
Click the button marked Height and highlight with the mouse the first occurrence

of the height field within the data as shown.

The height  information is identified and copied to the  second row under the label
headed "First Point Selected".

3. Complete the other fields and click OK to import the data.

The data will be transferred to the Main Screen as an active working plot.

Once the data has been imported, you should save the imported tidal record using the 
File>Save menu option as described on the following page. 

For a more detailed description on the operation of the import window and of the
Location, Gauge ID and Latitude and Longitude fields please see the section:  Importing
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Data:Tidal Height

1.6.2 Saving
To save a tidal record click the File>Save menu and enter the filename which you want
to save. If this file already exists you will be prompted as to whether the file should be
overwritten.

The tidal data will be saved in the internal format of GeoTide. Once you have saved a
tidal record you can load it at any time to edit it or to carry out a tidal harmonic analysis. 

1.6.3 Loading
To load a tidal record click the File>Load menu and click the file you want to load. The
progress bar below is displayed which shows the extent of the loading process and
provides you with the opportunity to cancel the load. 

After loading, the tidal record is displayed on the main screen as a graph in both the
Original and Working layers.  See the Main Screen Section for details on how to use the
graphs and how to change their scaling and size.

Note:
Once the tidal data has been imported, you should always use the File>Load menu to
load  the tidal data rather than repeating the import process. This is because GeoTide
tidal record files contain an internal audit of all data processing which has been carried
out upon or using the file. The files are also directly referenced by the analysis software
to maintain a quality audit. Re-importing the data and overwriting these files will overwrite
this audit trail.

1.6.4 Editing
GeoTide Analyzer does not require a continuous or regular data set in order to produce
an accurate analysis, and missing data or large gaps of even up to a year are not a
problem.  However, incorrect data such as rogue heights, sometimes known as outliers
(appearing as glitches or spikes), or points returning a fixed value (appearing as a
horizontal line), will dramatically affect the accuracy and speed at which the Analyzer can
establish the harmonic constants. 

Alternatively, too many points will slow the analysis process unnecessarily. In this case it
is better to sample the record to reduce the data set size.

Manual Edit
You can remove spikes and glitches manually. To do this use the mouse cursor to select
the point or points which are known to be incorrect. Then depress the Delete key. 

Automatic Edit
You can automatically remove points by:- 

· Averaging neighbouring points. This reduce noise and reduce data set size. 

· Sampling at a user defined time interval. This reduces the data set size. 
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· Filtering. This automatically eliminate rogue data points which are known to

have certain characteristics. 

1.6.5 Analysing
Display the Analysis Window by clicking the Analysis menu item

Before commencing tidal analysis you must ensure you have loaded a valid tidal record
containing good quality data.

Steps

1. Select the tidal analysis scheme which you want to use. The use of different tidal
analysis schemes is described in detail in Selecting a Tidal Scheme.

2. Decide on whether you want to use Matrix Inversion or Iteration methods. Matrix
Inversion is recommended for all schemes except for the UKHO Simplified
Scheme with Shallow Water Coefficients.

3. Click the Analysis button on the Analysis Window to start the analysis of the tidal
data into its separate tidal harmonic components. 

When using Matrix Inversion you will see a series of progress bars indicating conversion.

When using iteration you can observe the computed tidal curve changing as it optimally
fits the source data. This process can take many minutes or even hours, depending on
the accuracy settings, and tide record length, and the tidal scheme chosen. Whilst
operating, the error bar will generally decrease showing that the discrepancy between
predicted and observed curves is reducing. You can stop the iterative process at any
time, or you can wait until it reaches a given value. Once completed or stopped the
analysis constants may be viewed and saved. 

For a more detailed description on the operation of this window please see the section:
Harmonic Analysis. 
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1.6.6 Reporting
Display the Report Window by clicking the Report menu item. 

This window is used to produce a fully formatted report detailing the statistical accuracy
of your predictions, the value of tidal levels such as HAT, MSL and LAT and the tidal
harmonic constants. The report, suitable for inclusion in technical reports etc, is
generated in Rich Text Format (.rtf) and is compatible with most word processors
including Microsoft Word. 

Steps

1. Click to load an observed (.rec) data file as indicated.
2. Click to load a prediction file as indicated. Normally you would use a tidal

constants (.tc1) file  to create the predictions for the comparison statistics in your
report. However, in some circumstances you may wish to load a second (.rec) tidal
record. 

3. Click Create Report to create the report. This may take some time. You can save
the report to a file or print the report on your printer.

For a more detailed description on the operation of this window please see the section: 
Reporting.

1.6.7 Predicting
Display the Prediction Window by clicking the Predict menu item. 

Steps

1. Click the tidal constants (.tc1) file which you want to use for predictions 
2. Click the options to select the times of the prediction.
3. Click Predict to create the prediction graph - this will be displayed in the Prediction

layer on the main screen.

For a more detailed description on the operation of this window please see the section: 
Prediction.

Both this package, GeoTide Analyzer, and its sister software GeoTide Predictor can
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create tidal predictions. Both programs produce identical results since they use exactly
the same tidal prediction engine. However, predictions from GeoTide Analyzer should be
used for comparison and accuracy checks, while those from GeoTide Predictor should
be used for producing formatted output such as tide-tables, and graphs. For help on
GeoTide predictor please see the Predictor help file.

1.6.8 Making a Spectrum

Using the Spectrum Analyzer you can create a power spectrum of the tide. The source
data for this power spectrum can be  the observed tidal curve, the predicted tidal curve, 
or from the residual (observed - predicted).  The steps in creating a tidal spectrum are:

1. Loading a Tidal Record file
Use File | Load Record on the main window to load a tidal record. This will be used to
create the yellow line on the graph.

2. Loading a Tidal Scheme
The Spectrum Analyser also displays the constituent frequencies of the tidal scheme as
vertical lines. Use the top menu 'Analysis' to click the pull down to load a tidal scheme.
This loaded tidal scheme will be used to display the grey and white vertical lines on the
graph.

3. Load the Spectrum Analyser
Click the top menu labelled 'Spectrum' to display the above screen.

4. Creating a Scan

Click Scan or the left icon 
You will see the tidal power spectrum being drawn.

Notes

You can change the Graph Scale by using the Scale Icon  . Click this icon and drag
the line upwards (with a mouse drag and left click) to make the peaks larger or
downwards to make them smaller. Click the icon again to end using this facility.

You can set the Constituent Scale by using the constituent line icon . Click this icon
and drag upwards with (with a mouse drag and left click) to make the lines taller or
downwards to make them smaller. Click the icon again to end using this facility.

Note that as you move the mouse around the frequency corresponding to the horizontal
X value of the mouse pointer is displayed at the lower edge indicate the frequency.

.
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2 Main Screen

The main screen serves as a control center for editing and viewing data as part of data
pre-processing, and its main feature is a graphical display, with up to four layers of
graphs available. When a tidal record is loaded it is always displayed graphically in this
window. Tidal analysis is also initiated from this main windows using the Analyse top-
menu function.

The screen can simultaneously display four layers, these are the original graph, the
locally edited graph, the results of the tidal analysis curve, and a prediction curve, all in
different user selectable colours. The layers may be turned on and off using the "Plot
Controller" which is also activated under the View top-menu function.

The vertical axis scale and origin is normally automatically set, while the horizontal axis (
timescale) of the window can be set either manually or automatically. The horizontal axis
origin is determined by the horizontal scroll bar.

Cursor and point readouts are provided.

2.1 Menus

The top level menu items, shown above, are:- 

· File
Used to load, import or save data files, harmonic constants or to change settings.

· Data
Click Edit to remove or modify source data or to carry out an Undo command.

· View
Used to display logs, schemes and harmonic constants.

· Analyse
Activates the Tidal Analysis window which carries out harmonic tidal analysis.

· Predict
Activates the prediction window.
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· Spectrum
Activates the prediction window.

· Report
Activates the prediction window.

· Tools
Activates the Port Header Editor, the Encrypter and the Merge Tool.

· Help
Activates the help menu for help related tasks.

· Exit
This is an alternative way of closing the system. If the tidal record or location constants
have changed you will be asked if you want to save them.

2.1.1 File

The top level File Menu provides the following sub-menus:-

Load Record 
Loads a GeoTide tidal record in file (*.rec)

Save Record
Saves a GeoTide tidal record in file (*.rec)

Load Location Constants
Loads the harmonic constants from a GeoTide tidal constants file (*.tc1)

Save Location Constants
Saves the harmonic constants to a GeoTide tidal constants file (*.tc1)

Save..
Working Layer As
Analysis Layer As
Prediction Layer As

Import ASCII 
Depth: Imports records of tidal height data.
1D Stream: Imports records of tidal stream data.
2D Stream: Imports records of tidal stream data to create.
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Export ASCII 
Original
Exports this layer as a date/height time series
Working
Exports this layer as a date/height time series
Analysis
Exports this layer as a date/height time series
Prediction
Exports this layer as a date/height time series
Analysis Constants
Exports the analysis harmonic constants (& log) 
Prediction Constants
Exports the prediction harmonic constants (& log)

 
Create 2D Stream

Combines tidal stream harmonic constants (*.tc1) to produce vector stream
prediction constants (.tc2).

Settings
Used to change the main settings, for example to set the colours within the main
graph display

Exit
Closes the system. If the tidal record or location constants have changed you will be
asked if you want to save them.

2.1.2 Data

The Data menu gains access to the following options.

Sample
Enables you to take a subset of points in the tidal record by sampling - this can greatly
reduce analysis time. Click "Sample" to display the Sampling window.

Average
Enables you to take a subset of the points in the tidal record by averaging the values of
nearby points. This can reduce both noise on the signal and analysis time. Click
"Average" to display the Averaging window.

Filter
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Enables you to eliminate rogue data points (which are known to have incorrect values) in
a semi-automated way.

Undo
"Undo" restores the previously displayed tidal record.

Revert to Original
Reloads the tidal record previously loaded. 

2.1.3 View

The View menu gains access to the following options:-

Clicking any option causes the relevant  window to be displayed, each having the same
overall behaviour, but containing different information relating to the analysis process. 
Each is a text window, which can be closed by double clicking, and you can cut and
paste data from any text window into the clipboard for copying to another application. 

However you cannot edit or paste the data to this window.. 

The text windows displays either

· A log of the editing actions performed on  the input data.
· A tidal scheme,  i.e. a list of harmonic constants, which were sought when the

analysis was carried out.
· Harmonic constants i.e. the list of tidal components (amplitudes &  phases)

which were determined during an analysis session.

The menu items are:-

Original Log
Displays or hides a Log of all previous actions on data

Active Log
Displays or hides the actions carried out in this session e.g. point deletions

Analysis Scheme
Displays or hides the scheme used in this analysis session

Analysis Constants
Displays or hides the harmonic constants found in this analysis session
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Prediction Scheme
Displays or hides the scheme used for making the prediction constants

Prediction Constants
Displays or hides the harmonic constants found for the location loaded in the
prediction window.

2.1.4 Analyse

Click the top menu Analyse to display the Analysis Window. 

The Analysis Window enables you to analyse the tidal record in the Working Layer into
its harmonic tidal constants. 

Tidal Analysis can only be carried out on the Working Layer. 

2.1.5 Predict

Click this top menu item to display the Prediction window. 

Use this option to make a tidal prediction record from the tidal location constants (*.tc1)
in a file. 

The prediction record will always be shown in the Prediction Layer. 

2.1.6 Spectrum

Click the Spectrum menu on the top menu item to display the GeoTide tidal Spectral
Analyzer. 

This facility enables you to analyze your tidal record or the tidal residual (Observed
minus Predicted) as a Power Spectrum.

Using a power spectrum you can see the presence of tidal harmonic components in a
visual and intuitive way.  

2.1.7 Report

Click the Report menu on the top menu item to display the report generator facility.



25Main Screen

GeoTide Analyzer 3.0.x,  © 2015 Geomatix Ltd 

This  enables you to produce a computer generated report containing a comparison of
the observed and predicted tidal data, and with a listing of the tidal levels and tidal
constituents.  

2.1.8 Tools
The Tools Menu provides access to additional facilities which may be present or added
to GeoTide.

Port Header Editor
Use this option to change the port details within the record file or tidal constants file. 

Encrypter
Use this option to encrypt the tidal constants you have created so that its tidal constants
cannot be read by an end- user. 
This should be used if you are planning to distribute  files along with GeoTide Predictor
and if you plan to claim copyright ownership of the harmonic constants which you have
created.

Merge Tool 
This facility enables you to combine GeoTide Record files.

Exceedance Tables
Generates Tidal Exceedance Tables of 3 different types: High Tide, Maximum Daily, and
All Points. 

Copyright: Tidal Constants
Geomatix Ltd do not claim ownership of the tidal constants which you create using the
tidal analyser within GeoTide. 

Copyright: GeoTide Predictor
However we do expect customers to obtain the rights to copy and distribute the GeoTide
Predictor program.  Please contact us for further details of licensing arrangements for
distributing the GeoTide Predictor program to end-users.

2.1.9 Help

The Help menu provides access to the help system and to the Geomatix website. 
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The options are:-

Find
Opens the help file on the "Find" page

Index
Opens the help file on the "Index" page

Contents
Opens the help file on the "Contents" page

Geomatix Website
Opens a web browser on the Geomatix website

About
Displays version information of this program

2.1.10 Exit

Closing GeoTide

To close GeoTide you can clicking the File | Exit menu,  use the top menu Exit, or click
the close control button  X on upper left hand side of the window. Whichever way is used
the termination process is identical.

If, during this session, the settings or data has changed  you will be asked if you want to
save the changes before quitting the program, so that they are ready for the next time
the system is used.

Specifically this applies to the following:-

· changes to the data points within the tidal record
· creation of harmonic constants
· graphic settings for the main screen
· settings for spectrum analyzer

If any of these settings have been changed you will  be prompted as to whether you want
to save them.

Note You do not need to specify a filename for the system settings configuration.
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2.2 Graph Operation

The GeoTide Analyzer main screen displays a tidal curve with a readout of the mouse
cursor (as a cross) and a selected 'hopping' point (as a default-red square). As you move
the cursor over the graph area the pointer changes to a cross indicating the point
readout is active.  At the same time, the point with the nearest time value to that of the
mouse cursor 'hops' and is continuously highlighted by the square. Note that the cursor
position and the selected point values are also displayed as text above the graph. Only
one of the four layers can be used as a 'hopping' point readout at a time. The readout
layer is set as 'hopping' by clicking the text of the required layer in the Plot Controller
window and is called the active layer. 

Mouse
Delete. Use the left hand mouse key to drag and create a rectangle containing

the points you want to delete. 
Zoom. Double click the left or right hand mouse keys to zoom in or out.

Keyboard
The shortcut keys are:-

< moves the horizontal scroll bar to the left
> moves the horizontal scroll bar to the left
Delete deletes the currently highlighted point
Home moves the scroll bar to the left showing the start of the graph
End moves the scroll bar to the right showing the end of the graph
F5 redraws the graph.

Window
The main screen can be scaled, resized or scrolled at any time, with the graphs and
scaling being automatically adjusted.

The vertical axis (height scale and origin) of the graph is automatically set for the data.
However, the horizontal axis (timescale) of the window can be set either manually or
automatically using the pull down list box provided or by using a mouse double click to
zoom.
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2.2.1 Deleting Points
There are two ways of deleting points within GeoTide.

Deleting a single point using the Keyboard.

1. Move the mouse cursor over the graph. The nearest point to the mouse cursor is
highlighted by a small square which 'hops' along the graph. 

2. Use the keyboard 'Delete' key to delete this single highlighted point.

Deleting one or more points using the Mouse.

1. Click and hold down the left hand mouse key and drag the mouse to create a
rectangle superimposed upon the graph. 

2. Release the mouse key to delete all the points within the rectangle created. You will
be prompted  to confirm the deletion.
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Click yes to delete the points. The operation can generally be undone using the Data |
Undo menu.

2.2.2 Zooming
There are two ways of changing the horizontal time scale in GeoTide Analyzer, using the
Scale Box, or by using the Mouse.

1. Using the Scale Box

· The horizontal scale can be changed using the mouse buttons or by using the pull
down menu.

· The pull down list box on the main screen above sets the horizontal extent of the
graph, i.e. the duration from the left hand edge to the right hand edge of the
window.  

· The options  range from 1 hour to 16 years. 
· There is also a fit-to-width option which always shows the first point at the

extreme left and the final point at the extreme right.

2. Using the Mouse

Zooming In
Double click the left mouse button to Zoom-In.

Zooming Out
Double click the right mouse button to Zoom-Out.

An example sequence is shown below.
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Note: 
The horizontal scroll position is automatically adjusted to maintain the on-screen position
of the "Hopping Point" wherever possible.
The vertical scales is automatically selected to fit the maximum and minimum values of
the tidal records. 

2.2.3 Resizing
The main screen can be resized at any time. 

To resize the window move the mouse cursor to any edge or corner of the window and
drag as required. The displayed graph(s) will automatically re-scale and both cursor and
point readouts will be appropriately adjusted to preserve readout accuracy.

If a large number of data points are loaded (over 1,000,000) you may experience a delay
of some seconds (depending on your computer's specification and the size of the tidal
record) while the graph(s) are being redrawn. During this short time, you should wait and
let the computer carry draw the graph(s), rather than initiating any further processes.

The graphs which are to be redrawn is set in the Plot Controller window. Obviously the
more graphs to be redrawn the greater the delay.

Of course, resizing the window will change its physical scale but it will not change its
scale relative to the window height.
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2.2.4 Scrolling

The main screen can be scrolled at any time, both horizontally and vertically. 

Vertical Scrolling
When a file is loaded the vertical window scale is automatically set so that the highest
point appears at the upper edge and the smallest at the lower edge. However, you can
scroll the vertical scroll bar to offset the plot.

Horizontal Scrolling
When a file is loaded the horizontal scale is automatically set. You can scroll the graph
by using the horizontal scroll slider bar. (Obviously this is not possible when the
horizontal scale setting is Fit-to-Width.) Clicking the white horizontal scroll area (each
side of the slider) moves the graph by around 90% of its width, while clicking the scroll
buttons at the lower left and right side of the main window moves the graph by around
25% of its width. 

Tip: 
When scrolling with the slider bar, the date of the window is shown as the cursor
position. When graphs of many years are loaded, this can be a very useful way of finding
date regions within a graph.

2.2.5 Plotting
GeoTide Analyzer can hold and plot 4 separate tidal layers simultaneously. The Plot
Controller enables you to set which of these 4 records are displayed, and also which of
the four are active. The active layer is the layer in which the Point Cursor (red square)
hops from one point to another.
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The screenshot shows four layers being displayed simultaneously, the blue line showing
the residual error from an analysis rather than a tidal curve.

Check-boxes
Click the check-box, i.e. checking the box,  causes that particular graph to be displayed.
Unchecking the box causes the graph to be removed from the display i.e. it hides that
tidal plot.

Text
Clicking the actual text (Working, Original, Analysis, Prediction), rather than the
checkbox, sets that layer to be active i.e. so that the red marker will hop on that layer.
When clicked the bold font indicates which layer is the active layer. 

The number of points within each record is displayed to the right of the checkbox.

The Plot Controller window can be closed using the View | Plot Controller menu.

2.2.6 Graphic Settings

Click the File | Graphic Settings menu to change the colours and size of drawn points
of each layer and the background colour of the main screen. The selected colour and
size sets the colour and size of the highlighted point on the active layer. Clicking the
coloured boxes causes the windows colour selector to be displayed where you should
select the new color desired and click OK.
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Click the text boxes headed Size to change the drawing point size (in pixels) 

The option Fast Draw Graphics causes a faster set of drawing instructions to be used.
This is the recommended setting. The option is provided because very occasionally on
extremely regular data with spacing which matches the screen pixel size  a resulting
moire pattern can be generated which can be distracting.

If the settings have been changed you will be prompted whether you want to save them
when you exit the program.





Part

III
Importing Data
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3 Importing Data
Click the File | Import menu on the main screen to activate the Import Options Menu
as shown below.

The input data should be contained in a standard ASCII text file consisting of a series of
lines (rows) containing a tidal measurement and a date-time stamp (also known as a
date-time group or DTG). The DTG should consist of a text representation of the date
and time. Any number of header rows may be present at the top of the file.

Each line must be separated either by the Microsoft Windows separators
Carriage-Return (ASCII 13) and Line-Feed (ASCII 10) or Unix Line-Feed (ASCII 10)
character. Of course, the line separators are invisible to the user -  the text simply
appears as a listing in a text editor or word processor. 

The options for tidal measurement are as follows:-

Height
Each line should contain a  date-time DTG and a value of tidal height (or depth) as a
decimal number in  meters cms, mm, decimal feet, feet and inches, and fathoms.

1D Stream 
Each line should contain a date-time DTG and a value of tidal speed on each line as a
decimal number in meters per second, knots, miles per hour, kilometers per hour.  For a
1D  stream, the heading must, by implication, be the same for all of the points, either
because it is

a) in a known direction, such as in a narrow strait or river, or
b) a vector component of the tidal flow which has already been applied. 

2D Stream
Each line should contain a date-time DTG and a value of tidal speed on each line (as a
decimal number in meters per second, knots, miles per hour, kilometers per hour) and a
direction (in degrees) on each record. Such a file may have been logged and created
using a Doppler Current Profiler  (ADCP).

When importing new data into GeoTide Analyzer you are prompted with a warning that
the currently loaded records will be overwritten. Clicking OK to the warning will bring up
the usual File Open Dialogue Box where you should select the file to import and then
click "Open". The  progress bar below will be displayed.

In the case of 2DStreams you may be given the option of loading the same file again, for
taking vector tidal components. This is more fully described in the section entitled 



37Importing Data

GeoTide Analyzer 3.0.x,  © 2015 Geomatix Ltd 

Creating a 2D Stream. 

Note: On large files this window will show only the first 32kB of the file. However all of
the data file will be processed, even if it is truncated within the display. 

3.1 Tidal Height

Clicking the File | Import | Depth menu (and loading a valid ASCII source data file)
displays the Import: Height window above.  It is used to import data from an ASCII
source data  into the graphical main window. The purpose of the import window is as
follows:

1. Allocate the date and height fields,
2. To enter meta-data such as location, 
3. Change the sign / units of the data and add an offset, if required.
4. Load the data into the graphical main window

The content of the ASCII file is shown in the upper portion of the window, with scroll bars
to view the file. The steps to importing the ASCII file are:-

1 Setting the Delimited / Fixed Space option
This indicates the type of file you are importing. A delimited file is where there is
always the same character as a separator, often a comma or a tab. A fixed space file
is one where the data forms perfect columns which do not move to the left or right as
you scroll down the file.

2 Setting the Date and Height fields.
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The date and height fields are selected by highlighting the first occurrence of the data
with the mouse. To highlight  the relevant information move the mouse to the left of
the information, hold down the left mouse button and move the mouse to the end of
the information. Note that the whole field must be highlighted. If it is the last field on
the row highlight as far as possible to the right.

a) The Date Field.
Click the Date button and highlight the first row where a date is present. 
Note that the whole date must be highlighted. Use the pull down checkbox labelled
"Regional Settings" to determine the method of date conversion. The options are:-

(1). Regional Settings uses the window regional system setting and routines, or 
(2). US Date Conversion using our own internal routines  
(3). Non US Date Conversion using our own internal routines.
 

b) The Height / Depth Field
Click the Height button and highlight the first row where a height or depth is present.
Note that the whole date must be highlighted. If the value is a depth, rather than a
height, then click the invert button also.

3 Units and Corrections
 
a) Units

The units available are meter cm, mm, decimal feet, feet and inches and fathoms.
The conversion is carried out upon input. GeoTide Analyzer works internally
exclusively in meters.

b) Additional Correction to Date
A correction to the data in the time field can be incorporated here. For example if
the tide gauge is set to a different time zone  from the standard time zone for that
location. Enter a figure in decimal hours to add to the time.

c) Additional Correction to Height (CD)
A constant addition can be incorporated to allow for differences in Chart Datum
between the gauge and prediction datum required. Enter a figure to add in meters in
the text-box "Add(m)".

4 Meta Data
The Gauge ID, Location Name, Time Zone, Latitude and Longitude may also be set by
clicking the relevant button and then highlighting the information in a similar way to
setting the height and date fields above. We recommend that this data is always
entered for audit purposes.

i) Location Name
You can enter the name by typing or by clicking this button and then highlighting

the name in the data source window if present.
Note that you can enter here optional non western characters using their html

equivalents. 
If the western (ASCII) characters are to appear first they must be separated from

the non-Western characters by &nbsp; for example as:

Port Salalah&nbsp;&#1605;&#1610;&#1606;&#1600;&#1575;&#1569;&#1589;
&#1600;&#1604;&#1575;&#1604;&#1600;&#1600;&#1607;

Or if the Arabic is required first:
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&#1605;&#1610;&#1606;&#1600;&#1575;&#1569;&#1589;&#1600;&#1604;
&#1575;&#1604;&#1600;&#1600;&#1607&nbsp;Port Salalah

ii) Gauge ID
You  can  enter  the  Gauge  ID  by  typing  or  by  clicking  this  button  and  then

highlighting the GaugeID in the data source window if present.

iii)Time Zone
You  can  enter  the  time  zone  manually  or  by  clicking  this  button  and  then

highlighting the time zone in the data if present.

iv)Latitude
You can enter the Latitude by typing it or by highlighting the latitude  in the data

source window if present. 
Acceptable  formats  are  +/-decimal  degrees  or  dd  mm.mm N/S  or  dd  mm ss.ss

N/S)

v) Longitude
You  can  enter  the  Longitude  by  typing  it  or  by  highlighting  the  longitude  in  the

data source window if present. 
Acceptable formats are +/-decimal degrees or dd mm.mm E/W or dd mm ss.ss

E/W)

5 Import Button
To Import the data depressing the Import button. You will see a count of the number of
points imported. 
The imported points appear as the "Source" layer on the main window.

6 OK Button
Click OK to copy this information to the Working layer or click. 

You can click Cancel at any time to abandon the import process.

Note: On large files this window will display only the first 32kB of the file. However all of
the data file will be processed, even if it is truncated within the display.
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3.2 1D Stream

Clicking the File | Import | Import1D Stream menu (and loading an ASCII source data
file) displays the Import: 1D Stream window. 

The ASCII file should contain date-time and speed fields on each record. The direction is
assumed to be the same  throughout the file, either by virtue of its location, e.g. a narrow
strait or river, or because it has already been resolved by a 2 component vector tide
stream gauge.  The content of the ASCII file is shown in the upper portion of the window,
with scroll bars to view the file. On large files this window will show only the first 32kB of
the file. All of the data file will be processed, even if it is truncated in the  display. The
purpose of this window is to:

1. Allocate the date and speed fields
2. Convert the speed units
3. Allocate a stream direction to the data
4. Enter Metadata such as location, and position or click/highlight/select as with tidal

heights. 
5. Load the data into the graphical main window

The steps, which are very similar to those for tidal heights, are described in more detail
in the following section.

Note: On large files this window will show only the first 32kB of the file. However all of
the data file will be processed, even if it is truncated within the display.
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3.3 1D Stream: Steps

The steps in importing a 1D Stream are:-

1. Setting the Delimited / Fixed Space Option
This indicates the type of file you are importing. A delimited file is where there is
always the same character as a separator, often a comma or a tab. A fixed space file
is one where the data forms perfect columns which do not move to the left or right as
you scroll down the file.

2. Setting the Date and Speed Fields
Select the field by highlighting,  i.e. move the mouse while holding the left button
down. Note that the whole field must be highlighted. If it is the last field on the row
highlight as far as possible to the right.

a) The Date Field
Click the Date button and highlight the first row where a date is present.

b) The Speed Field
Click the Speed button and highlight the first row where a speed is present. Note
that this speed must all be in the same direction.

3. Units and Corrections

In Direction
Enter here the known direction of the stream in degrees. This direction is either
known because of its geographical shape or location, e.g. a narrow strait or river, or
because it has already been resolved, e.g. by a 2 component vector tide stream
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gauge.

Units
The units available are Meters per second, knots, miles per hour and kilometres per
hour. This conversion to meters per second is carried out upon import. For tidal
streams GeoTide Analyzer works exclusively in meters per second. 

4.  Meta Data
The Gauge ID, Location Name, Time Zone, Latitude and Longitude may also be set by
clicking the relevant button and then highlighting the information in a similar way to
setting the height and date fields above. We recommend that this data is always entered
for audit purposes.

i) Location Name
You can enter the name by typing or by clicking this button and then highlighting

the name in the data source window if present.
Note that you can enter here optional non western characters using their html

equivalents. 
If the western (ASCII) characters are to appear first they must be separated from

the non-Western characters by &nbsp; for example as:

Port Salalah&nbsp;&#1605;&#1610;&#1606;&#1600;&#1575;&#1569;&#1589;
&#1600;&#1604;&#1575;&#1604;&#1600;&#1600;&#1607;

Or if the Arabic is required first:

&#1605;&#1610;&#1606;&#1600;&#1575;&#1569;&#1589;&#1600;&#1604;
&#1575;&#1604;&#1600;&#1600;&#1607&nbsp;Port Salalah

ii) Gauge ID
You  can  enter  the  Gauge  ID  by  typing  or  by  clicking  this  button  and  then

highlighting the GaugeID in the data source window if present.

iii)Time Zone
You  can  enter  the  time  zone  manually  or  by  clicking  this  button  and  then

highlighting the time zone in the data if present.

iv)Latitude
You can enter the Latitude by typing it or by highlighting the latitude  in the data

source window if present. 
Acceptable  formats  are  +/-decimal  degrees  or  dd  mm.mm N/S  or  dd  mm ss.ss

N/S)

v) Longitude
You  can  enter  the  Longitude  by  typing  it  or  by  highlighting  the  longitude  in  the

data source window if present. 
Acceptable formats are +/-decimal degrees or dd mm.mm E/W or dd mm ss.ss

E/W)

Import Button
You will see a count of the number of points imported. The imported points appear as
the "Source" layer on the main window.

OK Button
Click OK to copy this information to the Working layer or click. 
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You can click Cancel at any time to abandon the import process.

3.4 2D Stream

Clicking the File>Import>Import2D Stream menu (and loading an ASCII source data
file) displays the Import: 2D Stream window. The content of the ASCII file is shown in
the upper portion of the window, with scroll bars to view the file.  The file should contain
date-time, speed and heading fields on each record. Its purpose is to:

1. Allocate the date, speed and heading fields
2. Enter Meta Data such as location, and position
3. Take the vector component of the speed and heading records
4. Load the data into the graphical main window

If the file has recently been chosen the data entry areas are not cleared in order to save
them all from being re-entered.

The steps, which are similar to those for 1D tidal streams, are described in more detail in
the following section.

Note: On large files this window will show only the first 32kB of the file. However all of
the data file will be processed, even if it is truncated within the display.
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3.5 2D Stream: Steps

The steps in importing a 1D Stream are:-

1. Setting the Delimited / Fixed Space Option
This indicates the type of file you are importing. A delimited file is where there is
always the same character as a separator, often a comma or a tab. A fixed space file
is one where the data forms perfect columns which do not move to the left or right as
you scroll down the file.

2. Setting the Date and Speed Fields
Select the field by highlighting,  i.e. move the mouse while holding the left button
down. Note that the whole field must be highlighted. If it is the last field on the row
highlight as far as possible to the right.

a) The Date Field
Click the Date button and highlight the first row where a date is present.

b) The Speed Field
Click the Speed button and highlight the first row where a speed is present. Note
that this speed must all be in the same direction.

c) The Heading Field
Click the Speed button and highlight the first row where a heading is present. 

3. Units and Corrections

In Direction
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Enter here the direction in which to resolve the stream in degrees. The speed and
direction recorded in the file will be resolved to form a new component in this
direction. When carrying out a 2D stream analysis the import process is repeated for
each of the two components. It is important to specify the two directions as
orthogonal i.e. 90 degrees apart. See Creating a 2D Stream

Units
The units available are Meters per second, knots, miles per hour and kilometres per
hour. This conversion to meters per second is carried out upon import. For tidal
streams GeoTide Analyzer works exclusively in meters per second. 

4.  Meta Data
The Gauge ID, Location Name, Time Zone, Latitude and Longitude may also be set by
clicking the relevant button and then highlighting the information in a similar way to
setting the height and date fields above. We recommend that this data is always entered
for audit purposes.

i) Location Name
You can enter the name by typing or by clicking this button and then highlighting

the name in the data source window if present.
Note that you can enter here optional non western characters using their html

equivalents. 
If the western (ASCII) characters are to appear first they must be separated from

the non-Western characters by &nbsp; for example as:

Port Salalah&nbsp;&#1605;&#1610;&#1606;&#1600;&#1575;&#1569;&#1589;
&#1600;&#1604;&#1575;&#1604;&#1600;&#1600;&#1607;

Or if the Arabic is required first:

&#1605;&#1610;&#1606;&#1600;&#1575;&#1569;&#1589;&#1600;&#1604;
&#1575;&#1604;&#1600;&#1600;&#1607&nbsp;Port Salalah

ii) Gauge ID
You  can  enter  the  Gauge  ID  by  typing  or  by  clicking  this  button  and  then

highlighting the GaugeID in the data source window if present.

iii)Time Zone
You  can  enter  the  time  zone  manually  or  by  clicking  this  button  and  then

highlighting the time zone in the data if present.

iv)Latitude
You can enter the Latitude by typing it or by highlighting the latitude  in the data

source window if present. 
Acceptable  formats  are  +/-decimal  degrees  or  dd  mm.mm N/S  or  dd  mm ss.ss

N/S)

v) Longitude
You  can  enter  the  Longitude  by  typing  it  or  by  highlighting  the  longitude  in  the

data source window if present. 
Acceptable formats are +/-decimal degrees or dd mm.mm E/W or dd mm ss.ss

E/W)

Import Button
You will see a count of the number of points imported. The imported points appear as
the "Source" layer on the main window.
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OK Button
Click OK to copy this information to the Working layer or click. 

You can click Cancel at any time to abandon the import process.



Part

IV
Editing Data
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4 Editing Data
Editing data is a most important part of the overall tidal analysis process, since
erroneous data points can slow the analysis convergence and lead to inaccurate
harmonic constants. 

Unlike some packages, GeoTide Analyzer does not require a tidal record at regular time
intervals to produce an accurate analysis, and missing data or large gaps in the record
are not a problem to the analysis system - provided they do not occupy a significant
portion of the total duration and the gaps themselves do not occur at regular intervals  

However, any incorrect heights within the tidal record will severely limit the accuracy of
the analysis process  and will considerably increase the time required for a satisfactory
iteration. Such erroneous points often appear as glitches or spikes within a tidal record or
as blocks of identical incorrect values. We strongly recommend that each record is
carefully examined and that such points are removed prior to its use for iteration. The
cause of such incorrect points can be various -  including instrumentation errors, data
transmission errors, keyboard errors, unusual weather or simply flotsam jamming a tidal
sensor.

As many as possible incorrect points should be removed prior to analysis. The old adage
from Cartography applies very much here: "When in doubt - leave it out!"

GeoTide Analyzer provides both automatic and manual editing facilities for the removal
of such points. 

The main Edit menu provides access to automatic editing (as sampling, averaging, and
filtering), while the main screen and mouse provide manual edit facilities. 

This section describes these methods of editing data in detail.

4.1 Sample

Click Edit>Sample on the main screen to display this window. 

Sampling  reduces  the  number  of  points  by  removing  points  from  the  working  layer,
subject to the time interval provided in the text box. Specifying too large a time interval
may reduce accuracy, while specifying too small an interval may leave too many points in
the  record  and  unnecessarily  slow  the  tidal  analysis.  GeoTide  Analyzer  will  typically
analyse records with between 5,000 to 500,000 points. The active elements are:-
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Interval
This is the minimum time interval between the output data points. 

Sample
Click to carry out the sampling process

Cancel
Click  to  abandon the sampling  carried  out  and restore  the  plot  to  the  state  before  this
window was displayed

OK
Click to accept the sampling already done and to enter it into the main window.

Comment
You  can  optionally  enter  any  comment,  such  as  your  reasons  for  carrying  out  this
sampling action, into the comment text-box.

Note: GeoTide Analyzer keeps a log of all sampling actions. 

4.2 Average

Click the menu Edit>Average on the main screen to display this window. 

Averaging reduces the total number of points, taking the mean of nearby source points
which  are  within  a  time  averaging  window.  The  width  of  the  time  averaging  window  is
user specifiable. Averaging should be used in preference to sampling, where there is a
random noise on the signal. Using too large an averaging time, however, whilst reducing
the  number  of  output  points,  will  also  reduce  the  tidal  range  and  prediction  accuracy.
GeoTide  Analyzer  will  typically  analyse  records  with  between  5,000  to  100,000  points,
depending upon accuracy and tidal scheme selected. The active elements are:-

Interval
This  is  the  minimum  time  interval  between  the  output  data  points.  Points  within  the
window are averaged, both in terms of height and time, to create a new data point. 

Average
Click to carry out the averaging process.

Cancel
Click to abandon the averaging carried out and restore the plot  to the state before this
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window was displayed.

OK
Click to accept the averaging already done and to enter it into the main window.

Comment
You can optionally enter any comment (such as reasons for carrying out this averaging
action) into the comment text-box.

Note: GeoTide Analyzer keeps a log of all sampling actions. The settings are internally
saved, along with any comment.

4.3 Filter

Click the main menu item Edit>Filter to display this window. Filtering is used to remove
incorrect  data  points  which  due  their  characteristic  values  are  known  to  be  incorrect.
Filtering  is  a  two  stage  process.  Firstly  the  points  are  identified  and  listed  for  filtering
according to the criteria which you have specified. Secondly, the listed points are deleted
from the record by clicking the Delete button. At any point you can abandon the search
for  points  by  clicking  the  List  /  Stop  button.  You  can  filter  by  Glitch,  by  Value  or  by
Block. 

By Glitch
A glitch is  characterised by the slope of  the graph between that  point  and its  following
neighbour.  Depending on  the tidal  range,  a  typical  figure  of  greater  than  4  meters  per
hour almost certainly indicates an erroneous data point. The glitch search is triggered by
a positive or a negative slope which exceeds the value set.
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By Value
Filtering by value enables you to remove points according to their value. Points which are
equal  to,  greater  than,  or  less  than  a  certain  value  can  be  automatically  listed  for
removal. This is useful since in many cases certain values or range of values are know
to be incorrect. For example when some tide gauges fail a figure of 99 is always returned
and if there is a data transmission or electrical problem, frequently the value stored is 0,
or a figure which is below the lowest astronomical tide  is returned if a tide gauge jams.
Such values can be removed automatically using this facility. 

By Block
Data  may  be  returned  where  blocks  of  adjacent  points  have  identical  values.  Such
problems can occur due to equipment failure.  Of course it  is possible,  depending upon
the time interval, that at high and low tide a few adjacent values will be identical. For this
reason you can set a figure for the minimum number of identical adjacent values which
will trigger this filter.

Note: Care should be exercised when using this filter facility not to remove valid data.

The active buttons are:-

List
This button initiates the filtering process. When in progress, its caption changes to Stop
to allow you to abandon a filtering action which is too time consuming or inappropriate.
Resetting the listing options clears the list and the points will not have been deleted. You
must explicitly click the Delete button (below) to delete the points listed.

Delete
Deletes all of the listed points identified in the deletion list.

Cancel
Click to abandon the filtering carried out and restore the plot to the state before this
window was displayed. Any comments entered will not be stored.

OK
Click to accept the filtering already done and to enter it into the main window. Any
comments will also be stored.

Comment
You can optionally enter any comment which will be stored regarding this filtering action..

Note: GeoTide Analyzer keeps a log of all filtering actions. The settings are internally
saved, along with any comment.
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4.4 Manual

The Point Cursor
As you move the normal cursor across the window a small red square, known as the
point cursor hops from one point to the next. This arrangement enables you to easily
identify and accurately readout the numerical values of an individual point without having
to position the mouse exactly over it. When displaying more than one layer you must
select the layer which is to be used for displaying the "hopping" point cursor.  This is
layer is known as the Working Layer. The numerical values of the point cursor are
displayed in the "Point" text box, while the normal mouse cursor position is displayed in
the "Cursor" text box. Values are shown in date-time and meters (or meters per second
in the case of tidal streams). 

Deleting a Single Point with the Keyboard
To delete an individual point, simply move the cursor left or right until the point cursor
hops to the point you want to delete. Press the delete key on the keyboard, and you will
be prompted to confirm that you want to delete this point.

Deleting One or More Points with the Mouse
To delete one or more points at once, drag the mouse across the points which you want
to delete whilst holding down the left mouse key.  As you drag the mouse a rectangle is
drawn, and the points within this rectangle are the points  you are selecting for deletion.
When you release the mouse button you will be prompted for confirmation that you want
to delete these selected points.

When you delete points from the Working Layer you can still see the points you have
deleted by looking at the Original Layer provided it is checked in the Plot Controller
window.

Points can be manually edited at any time therefore 'manual' is not an Edit menu item.
See Graphic Operation for other details

4.5 Undo
Click the main menu item Edit>Undo to carry out this operation.

On  most  operations  Undo  restores  the  tidal  record  as  it  was  immediately  prior  to  the
operation  being  carried  out.  For  example  if  filtering,  sampling  or  averaging  has  been
carried  out  and  OK  was  clicked  on  the  respective  window,  the  original  record  can  be
restored by clicking Undo. The original and working log are always modified accordingly.
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4.6 Revert
Click the main menu item Edit>Revert to Original  to carry out this operation.

Revert to Original  reloads the last tidal record which was loaded. The original and
working log are modified accordingly and all edit operations which have been carried
since the tidal record file was loaded - will be lost.





Part
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5 Harmonic Analysis
Harmonic Analysis is the process of converting the tidal data into harmonic constants. 

Before carrying out a tidal harmonic analysis you should ensure that the tidal record is of
sufficient quality, i.e. all erroneous (rogue) data points have been removed and that it is
of sufficient duration. The number of harmonic constants to be found is determined by
the tidal scheme. A more complex scheme will require a longer data duration, while a
simple scheme will operate more reliably on data of a shorter duration.  Ideally tidal
records should contain between 1000 and 1 million data points, covering anything from
14 days to 18 years. The points do not have to be a regular continuous record and gaps
within the record are quite acceptable.

The general process is

Analysis Prediction
Tidal Record(*.rec)        =>    Tidal Constants(*.tc1)         => 
Tidal Predictions

After loading a tidal record which of sufficient quality and duration, Tidal Harmonic 
Analysis is carried out to obtain the Tidal Constants File. This can then be used either
within GeoTide Analyzer of within GeoTide Predictor to make high accuracy tidal
predictions.

In GeoTide Analyzer, the tidal analysis is always carried out on the working layer  with
its results appearing on the Analysis layer.

The tidal harmonic analysis can be carried out in two ways, by Matrix Inversion or by
Iteration.

5.1 Selecting a tidal scheme

Click the Analysis menu on the main screen to display the Analysis window, a portion
of which is shown above. 

To begin tidal analysis, the user must first select a tidal scheme from the pull down text-
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box shown above. 

A number of  Analysis Schemes are included with the GeoTide Analyzer. They are listed
in the readme.txt file which is installed with the program.

5.2 Solve By

Solve By: Matrix Inversion or Iteration

These button options enable you to select the analysis method. These are:-

Matrix Inversion
Fast and accurate using the exact mathematical inverse of the prediction process. 
Cannot handle the UKHO Simplified method with Shallow Water Corrections.

Iteration
Slower than Matrix Inversion.
Uses the identical forward mathematics as in the prediction algorithm. 
Can handle all type of analysis including UKHO Simplified method with Shallow Water
Corrections.

5.2.1 Matrix Inversion

When the Matrix Inversion option is selected there are no further choices to be made.
Simply click the Analyse button to carry out the analysis..

At the completion of the analysis by matrix inversion, a  graph is displayed in the 
analysis layer, shown in blue, while the original data is shown in yellow. 
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In the above example there is good agreement between the two.

Our matrix inversion algorithm is blisteringly fast and normally provides no problems. 

However when a scheme has been chosen which is too complex for the duration of the
data the following warning or similar is displayed.

For example in the above case when selecting a mixed tide of between 1 year and 18
years analysis the error message is displayed.

The data duration can be readily determined by observing the messages for that layer in
the Plot Controller or by using the pull down menu above the graph on the main window
at the top left. This is shown below and is around 4 months duration.

In this case it is better to chose a tidal scheme which is designed for a shorter tidal
duration.
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5.2.2 Iteration
Click the Analysis menu on the main screen to display this window whose functions are
reviewed here.

Select Tidal Analysis Scheme
A list of tidal schemes from which the user should select the scheme they want to use. 

Load Previous
You can optionally click this button to load a previously save harmonic constants file in
which case the process starts from these saved values and not from zero.

Analyse
Click to commence the analysis process. Once running its label changes to Stop so that
you can halt the process.

Cancel
Click to cancel the analysis process.

OK
Click to close the analysis process.

Iteration Options 

· Until RMS Error is less than the Error Target
Halts the process when the error target is reached. 

· Iterate for n passes
Halts the process after n times around.

· Iterate for n minutes
Halts the process whenafter n minutes.

Error Target
Sets the value for the error target and changes the scale of the error and progress
thermometers. 

Dynamic Sub Sampling



60 GeoTide Analyzer

GeoTide Analyzer 3.0.x,  © 2015 Geomatix Ltd 

Checking this box increases the speed at which the program finds the harmonic
constants. 

Display Residual Error
Checking this box causes the residual error (i.e. the difference between the observed
and predicted) to be displayed rather than the predicted curve.

Shallow Water Coefficients
This check box enables an algebraic correction for non-linear tidal effects resulting in the
calculation of Shallow Water Coefficients. Only the UKHO Simplified Scheme currently
supports this method. 

5.2.2.1 Iteration Options

The iteration options are: 

Until RMS Error is less than the Error target
Use this option to stop the iteration when the error target has been attained. During
iteration the progress bar will display proportionately to the error attained. You can
change the required error target as described below.. 

Iterate for n passes
Select this option to Iterate for a given number of passes. You should enter the number
of passes required in the text-box provided. During iteration the progress bar will display
proportionately to the number of passes being carried out.

Iterate for n minutes
Use this option to iterate for a given length of time. You should enter the time in minutes
in the text box provided. the progress bar During iteration the progress bar will display
proportionately to the elapsed time.

Error Target
You can change the error target by changing this number on the Analysis Screen. Notice
that changing the value of the error target will automatically scale the error bar
thermometer which is displayed.
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Residual Error
This checkbox displays the residual error, which is the difference between the above
graphs rather than the predicted graph itself. Using this option together with the
Spectrum Analyser enables you to search for missing components more easily.

Dynamic Sub Sampling
The checkbox increases the speed at which the program determines the harmonic
constants. It does this by sub-sampling the loaded tidal record. The sampling interval
dynamically varies, so that as the error target is reached more and more points are used
from within the record. It can be clicked while the iteration is in progress.

Shallow Water Corrections are described in the following section.

5.2.2.2 Shallow Water Coefficients

Shallow Water effects can cause the tide to be non-sinusoidal, in extreme cases
resulting in standing tides or extra tides. These are handled in GeoTide Analyzer in two
ways, via harmonic overtones (included in the tidal scheme file) or by an algebraic
correction called the Shallow Water Correction. 

Shallow Water Corrections
This check box is displayed on the Harmonic Analysis window (shown above) only for
those tidal schemes which are appropriate, currently the UKHO Simplified Scheme.
Selecting the Simplified Scheme (which uses this method) displays the checkbox. When
checked, Shallow Water Corrections are algebraically generated for the group within the
scheme.

Shallow Water Corrections allow for non-linearity within the ocean in terms of its
response to the tidal gravitational potential. As such they allow for the amplitude and
phase of the overtones of the major harmonic components of the tide raising potential. In
the UKHO Simplified Scheme they are  algebraically calculated for the overtones of  only
the semi-diurnal components,  corresponding to the 4 times per day and six times per
day components. They are accordingly labelled f4,F4 ,f6,F6, in the location harmonic
constants log - where the lower case indicates the amplitudes and the upper case
indicates the phase in degrees.
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Shallow Water effects are described more fully in the Shallow Water Coefficients theory
section. 

5.2.2.3 Analyzing

Click Analyse to initiate the iteration process. 

Once clicked, the system continuously displays the progress of the tidal analysis, both as
a thermometer on this screen and by displaying an extra graph in the main screen in the
Analysis Layer - see below. The window contains a vertical thermometer which displays
the RMS Error and the horizontal black bar which displays the progress of the iteration.
The information box in the lower window area gives you the error which has been
attained. 

During analysis, a trial graph is continuously written to the analysis layer, and as time
progresses the graph which emerges becomes increasingly similar to the working layer.
The analysis graph below is shown in blue, while the original data is shown in yellow.
When the iteration condition has been attained the iterative process stops. Alternatively
you can click the Analyse button (now labelled Stop) to halt the process. 

The information box, a the lower centre of the tidal analysis window, shows the R.M.S.
error as 33.7mm. This is calculated for all of the points in the Working Layer. You can
also view the harmonic constants produced by accessing the menu option View>Analysis
Constants .

To conclude the Analysis session, leaving the harmonic constants in memory, you
should click the OK button. Click Cancel to exit the session without leaving the harmonic
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constants in memory. 

The next section describes how to save the harmonic constants you have created.

5.3 Saving Harmonic Constants

After completing an analysis you should always save the harmonic constants by clicking 
File | Save Location Constants and entering the filename. You can save the location
constants file anywhere on your computer system, it does not have to be saved in the
same folder as the tidal record from which it was derived.  However, we strongly
recommend that you adopt a standard folder structure for your work. If you have many
tidal locations you may want to create a folder for each location, each containing the
appropriate tidal record and harmonic constants files. Or you may decide to have a folder
for the data and a folder for the constants.

You can also export the harmonic constants file by clicking Export | Analysis
Constants. 

You can view the constants in the window on the Analysis page.

Finally you can place the constants in a report by using the Report facility.
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6 Predicting
Clicking the Prediction menu on the main screen displays the Graph Prediction window. 

This facility creates tidal predictions from harmonic location constants which you have
previously saved.

It can be used to compare predicted values with observed values, and to predict and plot
a tidal curve for comparison with an observed plot. In either case, you must first select
the desired location constants by clicking the  text-box labelled File. Then select the type
of prediction times to be used. The options are to : - 

· use times from points in the working layer 
· use times from points in the analysis layer 
· predict at regular intervals
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6.1 Comparing Predicted & Observed

Click either Points in Working Plot or Points in Analysis Plot to use the times of the
points in the respective layers as the prediction times. When using either of these two
options, the predicted points will naturally line up with the source points. This means that
the system can calculate and show the height discrepancy between the predicted and
observed or analysed graphs. The points with the greatest height discrepancy are listed
in the text-box labelled Point Discrepancy. They points are shown in reverse order of size
of discrepancy. The error shown is the RMS error in meters. You can change the number
of such discrepant points displayed by entering the number in the  text-box labelled
Show.

This facility can also be used to locate and eliminate erroneous data points such as may
be caused by typographic errors, tide gauge problems or unusual meteorological effects
such as storm surges. To do this arrange that the main graph window and prediction
window are both visible. 

To identify a point listed in the Point Discrepancy List click the point in the list as shown
in the above screenshot.

 

The main graph window will simultaneously show this point as the active point by moving
the red square point cursor to that point. It will also scroll as necessary, so that the point
can be seen on the display. Its value and height can be read from the Point # cursor
readout. This facility can be used at any graph scale setting.  You can delete this point if
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required by simply pressing the delete key. Or you can delete any number of points by
using the mouse drag facility. 

After deleting the point(s) the system will automatically update the discrepancy list.

6.2 Tide at regular intervals

The option to predict at Regular Intervals predicts the tide at regular intervals times
between a given start date and end date. By default the start and end dates are derived 
from the start and end dates of the record in the working layer. However the start and
end date can be entered into the text-boxes provided, or if you double click the date box
you can select the dates from a calendar (shown below). The time interval for predictions
can be set in the text box provided.

Click the Predict button to create the predicted curve.

Note that with this option the discrepancy figures cannot be calculated, since there is no
correspondence in time between the points with the graphs.  
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7 Reporting
A versatile report generator is included within GeoTide Analyzer which enables you to
produce a fully formatted report.

This report contains:-
 

· The results of a statistical analysis of the comparison of observed and
predicted data

· The tidal levels:  HAT, MHWS, MHHW, MHW, MHWN, ML, MLWN, MLW,
MLLW, MLWS, LAT

· A listing of the harmonic constants for that location.

The report is generated in Rich Text Format (.rtf) which is compatible with most word
processors including Microsoft Word.

The predicted data  is normally generated by comparing predictions derived from a
GeoTide harmonic constants (.tc1)  file with data in an observed (.rec) data file.  

You can also compare two tidal record files -  enabling you to generate a report on the
level of agreement with externally generated data. 

7.1 Functional Overview

Clicking the Report menu on the main screen displays this window. It comprises:

Facilities for 
Loading Observed data
Loading Predicted data

Options for Comparing Observed and Predicted Data

Options for Setting Parameters to be derived from Harmonic Constants (HCs) if loaded.

A Create Report button and report display.
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Facilities for saving, printing and copying the report.

A Close command button for closing the window.

7.2 Loading Data

Clicking the labels loads the files as indicated. Beneath each label is a thermometer style
progress bar showing the loading progress.  During loading, the label of these buttons
changes from Clear to Abort - thereby providing the user with the opportunity to halt the
load operation. The user can also unload a loaded file by using this button.

Observed Data
The observed data must be loaded from a tidal record (.rec) file. This box is synonymous
with the File>Load option on the main menu.

Predicted Data
Normally the predicted data is derived from a harmonic constants (tc1) file. Therefore a
user should click and load the relevant harmonic constants (.tc1) file for the location.
When loading such a file, the tide is calculated at each of the points within the
"observed" file (if loaded). Therefore the time taken to load increases considerably. This
is indicated in the progress bar. Also the progress is indicated numerically in the lower
information bar (not shown above) in terms of number of records calculated. 

Exceptionally it may be required to compare two tidal record files, for example when one
has been generated externally. Such an external prediction file should first be imported
and saved in the usual manner. Then it should be loaded as Predicted data by clicking
the appropriate (.rec) file. In this circumstance the comparison options are enabled but
the harmonic options are not.

7.3 Comparison Options

The above comparison options are enabled when both Predicted and Observed data are
loaded.

Date Time From Observed / Date Time From Predicted
Determines the source of the DateTime (DTG) to be used for comparison. If  'DateTime
From Observed' is chosen the system attempts a comparison at each DTG in the
Observed record. Similarly if 'DateTime From Predicted' has been selected the system
attempts a comparison at each DTG in the Predicted record. Normally, the Predicted
record will have been created from a loaded harmonic constant file at the times in the
Observed record, and so the two sets of data will have identical DateTimes. However in
cases where the Predicted file has been loaded as a tidal record file this setting becomes
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important.

Exact Match / Best Within 
Determines the degree of difference whish is tolerated between the DateTimes in the
Predicted and Observed records. Normally, the Predicted record will have been created
from a loaded harmonic constant file at the times in the Observed record, and so the two
sets of data will have identical DateTimes. However in cases where the Predicted file has
been loaded as a tidal record file this setting, and its corresponding time value becomes
very important.

Other
In addition the software automatically provides the following outputs in the report.

RMS Error (Quadratic Mean). This is the RMS Error figure between the two data sets.

Mean Absolute Error. This is the average of the absolute value of the error figures i.e.
without regard to its sign.

Maximum Positive Error. The largest positive value of difference between observed and
predicted. 

Maximum Negative Error. The largest negative value of difference between observed
and predicted.

7.4 Harmonic Options

The above Harmonic Constant options are enabled when a valid harmonic constants fie
has been loaded as a Predicted record. The checkbox options are

List Harmonic Constants
Check this box to output the list of harmonic constants within the report.

Derive MHWS MHWN MLWS MLWN HAT LAT ML
This cause a scan to be carried out of specified duration starting on the specified date.
the computer uses a brute force method to calculate the tidal parameters shown. The
default duration is 18.61 years after which the tides approximately repeat. When
checked, the figures are automatically included in the report.  Note that checking this
option considerably slows production of the report, which may take many minutes to
produce. The date formats should be entered as shown.

Other
In addition the software always reports the High water Lunitidal Interval as derived from
the phase of M2
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7.5 Generating
To generate a report click Generate Report button. 

Depending on the options chosen it may take a considerable time to produce the entire
report, perhaps many tens of minutes. 

The progress is indicated in the information text box at the lower edge of the window.

7.6 Saving

The above buttons are used to output the report. In each case its output is in Rich Text
Format (RTF) which is compatible with most word processors including Microsoft Word.

Print
Causes the document use the loaded printer driver to print out to user specifiable printer
with the usual options.

Save to File
Causes the document to be save d in a use specifiable location.

To Clipboard
Saves the file as an RTF document in the Windows Clipboard

Close
Closes the window and return to the main screen.
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8 Tools

The Tools Menu provides additional facilities which are added to GeoTide.

Port Editor
The Port Editor enables you to change the port details which are held within the tidal
record file (.rec) or tidal constants file(.tc1). You may want to change these detail
because they may have been entered incorrectly when you originally imported the data
or they may have changed for other reasons. For example you can enter an additional
name in a local script e.g. Arabic or Chinese, or you can change the default time-zone
here. These details which can be changed are currently:-

· Port Name
· Gauge ID
· Time Zone
· Position - Latitude and Longitude.

These same details appear verbatim upon the tide tables and graphs produced by
GeoTide Predictor.

Encrypter
Using the Encrypter utility you can encrypt  the harmonic constants which are distributed
to an end user, thereby preventing them from hacking the distribution code and
recovering the constants.

Merge Tool
The optional Merge Tool enables you to combine GeoTide Record files. This may be a
requirement, for example, as more tidal data becomes available from a tidal monitor.

Exceedance Tables
Generates Tidal Exceedance Tables of 3 different types: High Tide, Maximum Daily, and
All Points. 

8.1 Port Editor
The Port Editor enables you to change the port details within the record file or tidal
constants file.

These details which can be changed are currently:-

· Port Name
· Gauge ID
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· Time Zone
· Position - Latitude and Longitude.

These details appear verbatim upon the tide tables and graphs produced by GeoTide
Predictor.

You may want to change these details because they may have been entered incorrectly
when you originally imported the data or they may have changed for some other
reasons. For example, a location may have been renamed, its time-zone may have
changed, or you may require to enter an additional name in a local script e.g. Arabic or
Chinese. The tables in GeoTide Predictor can then contain the local script within the
displayed title and can display the updated information.

The difference between the two options is now described.

Record File
Making changes to the data in the Records File (i.e. the file with file extension .rec) 
means that all subsequent analysis using that record file will incorporate the changes
you are making.  As well as  filtering down into the tidal constants file the changes will
also subsequently appear into all tide tables, tide listing and prediction graphs made
using this constants file within GeoTide Predictor.

Constants File
Making changes to the data in the Constants File (i.e. the file with file extension .tc1) 
means that the changes will filter down subsequently into all tide tables, tide listing and
prediction graphs made using this constants file within GeoTide Predictor.  However, if
you carry out a new tidal analysis using the original record file the changes entered will
be overwritten with those in the record file and will not incorporate the changes that you
are make.  

8.1.1 Record File
Clicking the option Record File displays the Record File Editor.
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Here you can change following  data. 

Port Name 
This name will appear on all tables derived from this tidal constants.
Note that you can enter here optional non western characters using their html
equivalents. 
If the western (ASCII) characters are to appear first they must be separated from the
non-Western characters by &nbsp; for example as:

Port Salalah&nbsp;&#1605;&#1610;&#1606;&#1600;&#1575;&#1569;&#1589;
&#1600;&#1604;&#1575;&#1604;&#1600;&#1600;&#1607;

Or if the Arabic is required first:

&#1605;&#1610;&#1606;&#1600;&#1575;&#1569;&#1589;&#1600;&#1604;
&#1575;&#1604;&#1600;&#1600;&#1607&nbsp;Port Salalah

Gauge ID
Enter as an ASCII string.

Time Zone
Enter here four digits representing hhmm with an optional + or - prefix.
Note the prefix is + for West and - for East. This is the UKHO standard for time zones
and is the opposite way round from many modern documents e.g. telephone directories
etc.

Position
Latitude - entered as dd°mm.mm' followed by N or S
Longitude - entered as ddd°mm.mm' followed by E or W.

8.1.2 Constants File
Clicking the option Constants File displays the Constants File Editor.

Here you can change following  data. 

Port Name 
This name will appear on all tables derived from this tidal constants.
Note that you can enter here optional non western characters using their html
equivalents. 
If the western (ASCII) characters are to appear first they must be separated from the
non-western characters by &nbsp; for example as:
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Port Salalah&nbsp;&#1605;&#1610;&#1606;&#1600;&#1575;&#1569;&#1589;
&#1600;&#1604;&#1575;&#1604;&#1600;&#1600;&#1607;

Or if the Arabic is required first:

&#1605;&#1610;&#1606;&#1600;&#1575;&#1569;&#1589;&#1600;&#1604;
&#1575;&#1604;&#1600;&#1600;&#1607&nbsp;Port Salalah

Gauge ID
Enter as an ASCII string.

Time Zone
Enter here four digits representing hhmm with an optional + or - prefix.
Note the prefix is + for West and - for East. This is the UKHO standard for time zones
and is the opposite way round from many modern documents e.g. telephone directories
etc.

Position
Latitude - entered as dd°mm.mm' followed by N or S
Longitude - entered as ddd°mm.mm' followed by E or W.

8.2 Encrypter

Select the Encrypter option to display the Encryption Tool shown below.

This is used as the final step before distributing tidal constants.

Encrypting the information using a password means that users of the GeoTide Predictor
program will not be able to hack the harmonic constants.

The same password as is used here, must be entered into the GeoTide Predictor
Settings Panel, and once entered it is stored within the GeoTide Predictor user
configuration.

If a number of tidal constants files are to be distributed for use in the GeoTide Predictor,
the same password must be used for each tidal constants file distributed.
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Please contact us for details.

8.3 Merge Tool

Clicking Tools | Merge Tool runs the ImportMerge Tool facility shown below. 

This includes facilities for importing from Tide gauges manufactured by Log_aLevel and
Sonar Research and Development (SRD) and also for merging GeoTide .rec Files.

1. Simply select the tab for whether you want to use Log_aLevel, or SRD or whether you
wish to merge Record files.

2. Select the files you wish to convert or merge. When merging you can select the order
of the merge by selecting the file in the MergeList window and using the up and down
arrows.  

Click Convert and Save or Merge. You will be prompted for a filename.
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8.4 Exceedance Tables

This facility generates tidal exceedance tables of three types, High Water, Daily Maxima
and All Points. Exceedance tables are useful for assessing the deepest draft of vessel
which may regularly access a harbour and also for estimating overtopping and flood risk.

The source data for the table can be derived from one of the 4 graphical layers using the
listbox at the upper left. The table is displayed in the text area on the form. In the cases
of High Water and Daily Maxima tables the text area also lists, below the table itself, the
maxima which have been used to create the table.

Note: 
1. The contents of the text window can be selected and copied to other software e.g.
Microsoft Excel using the right mouse button and highlighting or select all.
2. The window can be maximised or resized.

ListBox 
Selects which graph layer to be used as  data source: Original, Working,  Analysis,
Predicted.

High Water 
Selects the type of table.

Search Width
Only applies to High Water Exceedance Tables. Sets the search window width in

hours. This width is used for determining a turning point.
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Minimum Number of Points
Only applies to High Water Exceedance Tables. Sets a minimum in hours. This

width is used for determining a turning point.

Height Threshold
Only applies to High Water Exceedance Tables. Rejects all turning points with a

value below this figure.

Reject Multi-Tides
Only applies to High Water Exceedance Tables. Rejects Standing / Extra / Multi-

Tides occurring within this time (in hours). The highest turning point within the time
window is chosen for the exceedance table.

Daily Maxima 
Selects the type of table.

All Tide Data Points 
Selects the type of table.

Table Interval
Applies to all types of table. Sets the value of the row interval in the table.

HT Format
Applies to all types of table. Provides the format string for the listing of height in

column 1 of the table.*

Percent Format (%)
Applies to all types of table. Provides the  format string for the listing of percent in

column 4 of the table.*
 
*Uses standard Microsoft / VBA / Excel format strings such as "#0.00".

Go
Click this command button causes the table to be calculated and displayed
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9 Spectrum Analyser
GeoTide contains a  fully  featured tidal  spectral  analyser  accessible  from the Spectrum
top-menu.

Spectral  analysis  converts  a  time  series  into  a  spectrum,  showing  the  power  of  each
frequency plotted on a graph with power on the vertical axis and frequency horizontally.
Acting  in  a  manner  analogous  to  a  glass  prism  which  splits  light  into  its  component
colours, spectral analysis in tidal work can reveal the presence of missing or unexpected
harmonic components.

Unlike tidal harmonic analysis which searches for and fits the amplitude and phase of 
only known tidal constituents, spectral analysis can reveal the power of any
frequency present, even those not predicted by linear tidal theory.

 And of course, there is the point, harmonic analysis is based upon linear theory and
struggles to predict frequencies which have been generated by non-linear effects in the
ocean even if they originate initially from an astronomical origin.

GeoTide-Prism can be used in a number of different ways, helping to identify missing or
superfluous tidal components, and helping to discriminate between weather induced tidal
variations and true astronomical variations.. 

Its main operating features are:

· Graphic display of spectrum of the source data and the harmonic constituents
in the analysis scheme currently loaded.

· Icons: At the upper edge are a number of icons which enable you to change the
display scales and settings. 

· Cursor: At the lower edge is a display of frequency, XDO, nearest line and
nearest group. 

The window is re-sizeable and may be re-sized during its operation.

9.1 Functional Overview
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Clicking the Spectrum menu on the main screen top menu activates the GeoTide
Spectrum Analyzer, initially with a blank display screen as shown below.

The screen consists  of  a  resizeable window,  a  top menu and a set  of  tool  icons which
(from  left  to  right),  start  a  scan,  provide  access  to  settings,  set  lower  and  upper  scan
frequencies, set the vertical scale of the graph, and set the vertical scale of the harmonic
constituents (if present).

 

9.2 Tool Icons

The clickable icons functions are shown below.  Once an icon is activated all  the other
clickable icons are disabled until the process is completed. 

 Creates the tidal power spectrum.

X Scale
Zooms in by changing lower and upper frequencies of the horizontal axis of the display.
To zoom and change the x axis scaling, click the icon and then click and drag the mouse
from the lower limit required to the upper limit required using the left mouse button. Click
this icon again to complete the process. You can also change this value by entering text
into the lower and upper frequency limit boxes to the right of the icon.

Y Scale
Changes the scale of the spectral plot.  Click the icon and then drag the mouse cursor
down the image to set the new scale required. Click the icon again to complete the
process.

Harmonic Relative Y Scale
Changes the vertical scale of harmonic plot relative to the line plot. Click the icon and
then drag the mouse cursor down the image to set the new scale required.  Click the
icon again to complete the scale change.
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Settings
Click the icon to displays the settings screen so you can change the display behaviour, 
colours and set the anti-alias window function. Clicking again closes the settings screen

9.3 Missing Scheme Constituents

It  is  always  possible  that  a  tidal  component  is  present  in  the  data  which  was  not
anticipated.  This may be suspected during tidal  analysis,  or  when comparing  predicted
with observed data. 

However  identifying such a component  without  a  spectral  display  is  not  easy,  involving
numerous trial and error with different tidal schemes.

Our Tidal Spectral Analyser can help you to determine the existence of such a
component, ready for inclusion in a tidal scheme. Typically, the components could be
due to an unexpected large shallow water component, or due to an unexpectedly large
annual variation which may be influencing tidal range. 

To establish if your source tidal scheme has missing components 

1. On the settings window check the checkbox is set for display harmonic
constituents, 

2. Ensure the number of points is adequate and the frequency range is not too
great (see resolution information)

3. Click the scan   icon.

Visually compare the existence of peaks with the harmonic constituents. In the example
above a harmonic constituent is present in the tidal scheme which is not present at all in
the power spectrum. Using the Spectrum analyser this can  immediately be seen since
the vertical line on the right does not correspond with a peak in the tidal curve.

Hint: Move the cursor to the component peak to identify its frequency and Doodson
number 

Conversely, GeoTide-Tidal Analyser can be used to reassure you that all necessary
components are indeed present.
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9.4 Redundant Scheme Constituents
It is possible that a component may be present in a tidal scheme which is not present in
the source tidal data.  Removal of an unused component increases analysis speed and
may also increase analysis accuracy due to the reduction in the number of unknowns.  

The lack of a constituent in the display can be due to a number of reasons other than its
non-existence. It is important to eliminate the possibilities below before concluding that a
component doe not exist in source data.

1. The source data record is of insufficient duration to resolve this constituent, and may
have been masked by resolution effects. Remedies:
a. Review the issues raised in the section on resolution. 
b. Use as long a duration as possible. 

2. The number of points in the display setting within the Spectrum Analyser is
insufficient. Remedies:
a. Change the lower and upper limits of the display to zoom in on the component in

question. 
b. Increase the number of points in the display setting window.

The above limitations do not apply generally to the tidal analysis process - only for the
identification of the absence of a component within the spectral analysis.

It is always better to create a new scheme for a given location rather than to modifying
an existing scheme file.

Before modifying any tidal scheme file you must be certain that you have considered all
possible impacts on the analysis in every location in which the tidal scheme is applied. 

Warning: Do not change tidal scheme files unless you have thoroughly understanding of
the issues involved.

9.5 Sampling Issues
The Nyquist theorem tells us that the sampling rate must be greater then twice the
highest frequency within an analogue signal in order to avoid a phenomena known as
aliasing. Aliasing is the generation of artificial frequencies components due to
inadequate sampling. In tidal work the highest frequencies are encountered in tides with
non-sinusoidal profiles. Frequently tidal overtones are invoked for the calculation of
Shallow Water Components of up to 6 times per day. The user should ensure that the
tidal source data is sampled sufficiently frequently in order to avoid aliasing, otherwise
spectral components may appear in the display which do not actually exist.

9.6 Resolution Issues
Spectral analysis has an inherent resolution limit, which is dictated by the duration of the
source tidal record. This resolution determines the discrimination between adjacent
frequency channels, and the precision with which the frequency of a component can be
measured.
 
As a general rule if the tidal duration of source data extends over n days, the resolution
will be 1/n days. This is the half-width of the displayed line, the full width is twice this
figure. Individual tidal frequency components having a frequency closer than this will not
be resolved. Furthermore, it is entirely possible that such closely spaced harmonics are
out of phase during the sampling period and effectively therefore cancel out - resulting in
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the non-appearance of either of the components on the spectral display.

The remedy is to always ensure that the duration covered by the source data is sufficient
- this  increases the resolution and will mean that such components are shown as
separate peaks whether or not they are in or out of phase.

9.7 Meteorological Tides
Tides of non-astronomical origin (e.g. drying of land, annual rainfall, melting of ice,
seasonal winds, changes in air pressure) can have a greater effect than their equivalent
astronomical components. Furthermore, while astronomical effects are entirely
predictable, meteorological components are not. When meteorological induced
components interact with astronomical constituents the resulting modulation has a
considerable effect upon the line shape, broadening its base considerably. 

In situations where many adjacent harmonic lines are affected by meteorological
conditions the peaks consequently appear to stand upon a broader baseline shoulder of
noise. 

The screenshot shows the semi-diurnal tidal components standing upon a shoulder of
meteorologically induced noise (annual flooding) from an 18 year tidal record in
Galchipa, Bangladesh.
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9.8 Display Settings - Parameters

Clicking the icon  displays the settings screen above so that you can change the
display behaviour and colours below.  The active features are:-

Source
Determines which plotting layer on the main screen is used for the spectral analysis.
Original, Working, Analysis and Prediction. See Plot Controller.

Number of points
Sets the number of points used in the spectral display. You should ensure that the
number of points being used is sufficient to display any peak, bearing in mind the
frequency resolution.

Logarithmic Frequency
Converts the x axis to a logarithmic frequency axis

Display
Checkbox enables display of harmonic constituents of the analysis scheme

Closest Harmonic to Cursor
Sets the colour of the harmonic line which is closest to the mouse cursor

Closest Group to Cursor
Sets the colour of the harmonic group which is closest to the mouse cursor

Other
Sets the colour of all other non-highlighted lines and groups. 
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9.9 Display Settings - Data Windows
GeoTide Prism has a choice of built-in data windows (also known as spectral weighting
functions). Please see the next page for a detailed discussion on the purpose of data
windows. A number of data windows can be enabled on the settings screen, and the use
of more than one data window at a time is fully supported for comparison purposes. 

Click the appropriate checkbox to use the respective anti-leakage window in the
spectrum analyzer or set the colour of the display by clicking the respective coloured
square. 

Window Method Formula

Hamming 0.54 + 0.46 Cos (2 ð i / N)

Hanning 0.5 + 0.5 Cos (2 ð i / N)

Welch 1 - ( (i - N / 2) / (N / 2) 2

Bartlett 1 - 2 i / N, 1+2 i /N, 0

None 0,1,0

9.10 More on Data Windows
Spectral analysis behaves as if the input data wraps around from beginning to end. i.e. it
assumes a repetitive waveform of an exact whole number of cycles is being converted.
When the waveform does not contain an exact number of cycles, the discontinuity
generated by this implied wrapping process creates artefacts - i.e. frequency
components appear which do not really exist. This process is also referred to as spectral
leakage. These artefacts occur at frequencies having integral multiples of the inverse
sample duration. Thus They always appear at the lower edge of the spectrum. This is an
intrinsic consequence of any spectral analysis process. 

The magnitude of the artefacts can be decreased by applying a data window to the input
data. This reduces the size of the artefacts but the price paid is a loss in resolution. 

GeoTide Prism has a choice of built-in data windows. These can be enabled on the
settings screen, and the use of more than one data window at a time is fully supported
for comparison purposes. 

The screenshot shows the artefacts generated from an 18 year tidal record. Without a
data window (grey) the series of generally decreasing artefacts are shown, whilst with
data windows (other colours) the effects are considerably reduced. The peak shown at
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0.0027 per day is an annual tidal component (probably of non-astronomical origin) which
is clearly distinguishable from the artefacts.

Note: An alternative practical measure is to increase the duration of the sample, since
this effectively shifts the leaked frequencies to a lower portion of the spectrum, and away
from the frequency of interest. 
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10 Logs, Schemes & Constants
A simple text viewer is included for viewing Logs, Schemes & Constants. The
behaviour of the viewer window is the same whichever type of data you are examining.
This section describes the use of the text viewer and what it displays.

The view menu causes the appropriate text viewer to be displayed.

As a text window, it can be closed by double clicking, and you can cut and paste data
into the clipboard by right clicking. You can also display it or hide it by using the
appropriate view menu. You cannot edit this data. 

Log
A comprehensive log of actions is continuously taken while editing and analysis
operations are undertaken. This enables an operator to rapidly locate problems and to
find out how they were caused. The logs are embedded in the respective tidal record
files. Logs for the original layer and working layer can be viewed. 

Schemes
Tidal Schemes consist of a list of tidal harmonics which are to be sought during the
analysis process. Information is included regarding groups of tidal harmonics and the
type of shallow water corrections which are to be used. A different scheme may be
loaded for analysis or prediction so you can view these separately. You can view here
the scheme associated with the analysis layer and the prediction layer.

Constants
Harmonic Constants are the products of the analysis process, and contain the
amplitudes and phases for each tidal component (or group of components). A different
set of constants may be loaded for analysis or prediction so you can view these
separately.
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10.1 Original Log

The Original Log is text window (below) showing a complete history of those operations
which have been carried out on the source tidal data (.rec) file which was loaded. It
includes details of points which were removed, sampling and averaging actions, but not
tidal analyses.

The lines starting with a single quote ' show the log information describing how the
operation was carried out.

The lines starting with a '#' show internal information which is used by the system.

10.2 Working Log

In addition to containing the details of the Original Log, the Working Log includes the
additional operations such as deleting or sampling, which have been carried out during
this session. When the tidal record is saved this information is embedded in the file so
that it will appear within the original log in future.
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10.3 Analysis Scheme

Shows the contents of the tidal analysis scheme file (*.sch) which is being used for
Analysis (if loaded). 

Lines beginning with a quote ' are comments which have been entered into the system
when the scheme was prepared.

Lines beginning with '#' are group or component names.

Lines beginning with numbers are Doodson coefficients.

10.4 Analysis Constants

Shows the tidal harmonic constants which have been created by the tidal harmonic
analysis during this session.
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Lines beginning with a '#' are variables which are required by the internal system.

Lines beginning with a ' are the settings on the analysis screen when the analysis was
carried out.

Lines beginning with #GROUP show the name phase (in degrees), and amplitude and of
each group.

10.5 Prediction Scheme
This menu option causes the Prediction Scheme to be displayed in the text viewer,
similar to the Analysis Scheme. The Prediction Scheme is the scheme which is used to
create a Prediction layer (if loaded). 

10.6 Prediction Constants
This menu option causes the Prediction Constants to be displayed in the text viewer,
similar to the Analysis Constants. The Prediction Constants are the harmonic constants
which are used to create a Prediction layer (if loaded). 
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11 Creating a 2D Stream
A two dimensional tidal stream prediction can be created using GeoTide Analyzer by
using two sets of orthogonal components (i.e. components at right angles). We assume
here the source data consists of speed heading and date-time. The steps are:-

1. Import the source data using the 2D Stream import option described in the 
Importing Data section. Set the direction at 000* to resolve the component to a
Northerly direction.

2. Process the same source data using the 2D Stream option but set the direction
to 090* to resolve the component to an Easterly direction. When processing
the same file again you will notice that the various meta-data boxes are
pre-filled to save you re-entering the data. Note: 

3. Create the tidal harmonic constants for each 1 dimensional set of data.

4. Combine the two sets of one dimensional location constants into a (*.tc2) file.
This can then be input into GeoTide Predictor for creating predictions of 2D
Streams. 

The following section describes how to combine the two sets of constants representing
orthogonal components.

* You could use any other directions provided they subtend an angle of 90 degrees. This
may be preferable if the stream is not running in an open ocean and is constricted to run
in a straight or channel. 

11.1 Merging 1D streams

Click the File>Create 2D Stream on the main screen to activate this facility.

This screen is used for combining two sets of location constants, each representing
orthogonal (right angle) components of the same stream. Click the left and right hand file
text boxes to load the two location constants file. These files have file extension (* tc1).
The system attempts to combine the two sets of data, and it checks for any
incompatibility in the data.  During this process GeoTide Analyzer renames the tidal
constants files corresponding to the streams having file extension ".tc1"  to ".tsc" and it
creates a new file with file extension ".ts2" which contains information about the tidal
stream components.

Note: Warnings are produced when the following data do not match between the files:-
· location
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· scheme
· position
· import file
· mode

Terminating Errors occur when

· Data was not imported as a stream
· The component directions are not at right angles

The program also informs the operator when the two sets of data have been successfully
merged into a (*.tc2) file.
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12 Harmonic Tidal Theory
Tidal harmonic theory explains that the astronomical tidal height anywhere in the world
can be represented by the sum of a set of tidal frequency components, called tidal
harmonic constituents. 

Although tidal theory provides the frequency of these harmonic constituents, it does not
provide - for a given location - the amplitude or phase of these components. The
amplitude and phase of these components can only be theoretically calculated for a
spherical frictionless earth with no land masses. The variously shaped land masses and
sea floor has a complex effect upon water flow which currently is not amenable to
computer modeling. Therefore the amplitude and phases of each component must be
calculated empirically from observed data..

Tidal Analysis calculates the amplitude and phase of each known harmonic frequency
component by an empirical process of trial and error called iteration. The set of
amplitudes and phases which are determined by the analysis for a given location are
called  the tidal Harmonic Location Constants.

12.1 Tidal Schemes
The list of tidal harmonic components sought during a tidal harmonic analysis is called a
Tidal Scheme or Tidal Schedule.

You can think of the Tidal Scheme as being a general template, while the Harmonic
Location Constants are the particular fingerprint for a given location. 

Sometimes the Tidal Harmonic Constituents are grouped together in order to reduce the
number of unknown quantities within the mathematics. This is an approximation which
can considerably reduce the computational effort  required, and can actually increase the
accuracy for a given computer effort. The tidal scheme also includes information on
these groupings.

Complex tidal curves may also require the inclusion of harmonics of the tidal
constituents. These harmonics are also listed within the Tidal Scheme.

Note
For the analysis of tides, tidal Harmonic Analysis is much more efficient than its more
general relation Fourier Analysis. In Harmonic Analysis, the frequency of each
component is already known whereas in Fourier Analysis the frequencies are not known.
In either system neither the amplitude or phase of the components are known. Tidal
Spectral Analysis uses Fourier Analysis and is useful for searching for unexpected tidal
components, while tidal Harmonic Analysis is used for searching for known components.

12.2 Tidal Groups
Unfortunately, some of the harmonic components being sought may have very similar
frequencies, and therefore a considerable period of time (sometimes years) is required
before these components manifest themselves by going in and out of phase with each
other.  If the tidal source data does not extend over this period of time, the analysis
process cannot resolve the amplitude and phase of each component.
 
Although tidal theory cannot give the absolute amplitude and phase at a given location, it
can fortunately give the relative amplitude and phase of the nearby components,
provided the frequencies are sufficiently close together. In such cases, an approximation
can be made, by grouping those components with a similar frequency into a single
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component called a tidal group. 

By grouping such similar frequency components, the tidal analysis has only to determine
a single amplitude and phase, rather than the amplitude and phase for each component
within the group. Therefore tidal grouping enables the tidal hydrographer to use source
data which extends over a considerably shorter time -  compared with tidal analysis
without grouping. 

GeoTide Analyzer supports the use of tidal groups within its tidal scheme files, as well as
individual harmonic constituents.

12.3 Shallow Water Coefficients
Normal tidal theory is based upon the concept of linearity, which assumes that the
astronomical tide can be represented as a simple sum of each individual frequency
component. 

However in some locations, especially those with extra-tides or standing tides,
components of higher frequencies are generated, not directly from the gravitational tidal
potential arising from the sun and moon, but by non-linear generation of harmonic
overtones within the ocean. In addition to the simple overtones, harmonics and sum and
difference frequencies of frequency components are also created. Such non-linear
effects mainly occur in shallow waters and so historically are called shallow water
overtides, extra tides or standing tides.

Corrections for this non-linear effect are implemented in two main ways, by using either
harmonic overtones or by using shallow water corrections. 

Harmonic Overtones
Astronomical tidal theory can fortunately be used to provide the frequency of the
overtones and of the sum and difference frequencies. Consequently a simple extension
of the tidal scheme to include these additional frequencies can be used to account for
the shallow water effects. These are known as the Shallow Water Constituents. They are
calculated for each individual overtone..

Shallow Water  Correction
This method avoids the calculation of the individual overtones by assuming that the
corrections will arise mainly from the (usually) larger semi-diurnal tide. It calculates those
amplitudes and phases for the second overtone (at 4 times per day) and third overtones
(at 6 times per day). These F4 and F6 components are used by the UKHO in the
Admiralty Simplified Scheme.

Analyzer supports both the harmonic overtone scheme and the shallow water correction
method. Clicking the checkbox labelled SWC enables the Admiralty Simplified Scheme
(Shallow Water Correction Scheme) used by the UKHO, while leaving the box
unchecked uses the Harmonic Overtone method (provided the overtones are listed within
the scheme file).

12.4 More on Schemes
There are over 10,000 known tidal components and it is impractical to include them all
within a tidal scheme even if they are grouped. A tidal scheme with too many
components will actually be less accurate (due to the increasing number of unknowns)
and will be slow. However tidal schemes which do not have a sufficient number of
components will not be universally applicable. As usual a compromise is required, it
being advantageous to use a number of different schemes, according to the duration of
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the tidal source data available and the complexity of the tidal curve. 

Source Data Duration
As a general rule if the tidal duration extends over n days, individual tidal frequency
components which have a frequency closer then 1/n days will not be resolved. Therefore
such components, which are closely spaced in frequency, should be included as
members of a group rather than individually. therefore the tidal scheme chosen is related
to the duration of the tidal source data.

Tidal Curve Complexity
Simple tidal curves, having a substantially sinusoidal shape, require the inclusion of only
the fundamental tidal components. Tidal curves having a non-sinusoidal shape require
the additional inclusion of overtone, sum and difference components, which may slow
analysis. Curves having substantial symmetry but a flattening at the top and bottom
require the application of even harmonics of the fundamentals. Tidal curves which are
triangular in shape, i.e. sharp at the top and bottom require odd harmonics. Those which
lack symmetry may require both even and odd harmonics. These can be odd or even
harmonics can be incorporated within the Tidal Scheme files as desired.

12.5 Meteorological Effects
Conventional tidal theory assumes that the frequency components of the tide arise only
from the action of the tidal gravitational potential i.e. pull of the sun and moon. It is the
effect of this tidal gravitational potential which is termed the astronomical tide. 

In some locations, in addition to the usual astronomical tide there may also be a sizeable
meteorological tide. 

A meteorological tide arises from meteorological effects, such as the seasonal drying of
land, seasonal rainfall, summer melting of winter ice, seasonal winds, changes in air
pressure or even annual changes in salinity.  In some locations, the meteorological
components can have a significant or even greater affect than the purely astronomical
components.  Furthermore, since the meteorological tide is derived from the weather, it
has inherent statistical fluctuations, while the astronomical tide being derived from the
motion of the sun, earth and moon, is always precisely predictable. In some extreme
cases, the seasonal changes may affect not just the mean level but also the daily tidal
range.

During tidal analysis, the meteorological tide can be mistakenly attributed to the
astronomical tidal components. For example, annual changes in level can be attributed
to the annual astronomical component (of frequency once per year) while annual
changes in range can be attributed to two or more closely spaced astronomical harmonic
components within the daily and semi-diurnal astronomical tidal groups.

The use of astronomical components to account for such meteorological effects can
never lead to precise predictions.  Furthermore, if  tidal groups are being used, the tidal
analysis assumes that the relative amplitude and phase of the components within a
group are fixed. If some components of that group have an amplitude and phase
primarily dictated by meteorological conditions, while others are dictated the tidal
gravitational potential, the assumption that the relative amplitudes and phases hold
across a group is  no longer valid. 

Therefore where large annual meteorological effects are present, the use of groups is
discouraged.
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12.6 Statistical Accuracy
There are any number of statistical measure of accuracy between an observed data set
and a predicted data set which can be used. The definitions of the those used within
GeoTide - standard deviation / RMS Error / Quadratic Mean and Mean Error are listed
below.
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duration     56, 68
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edit     15, 20, 22, 48

editing     13, 22, 29, 52

encryption     76, 79

erroneous     56

error     24, 48, 60, 66, 67, 70, 71, 107

Exceed     81
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Exceeding     81

exit     20, 21, 26

exitting     26

export     21

exporting     21
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FastDraw     32
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file     20, 59

filter     22

filtering     10
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finding data     31

fixed     44

flood     106

flooding     88

flow     40, 43, 100

folder     63

folders     10

Format     80

fourier     24, 84, 85, 104
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- G -
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Gauge     36, 37, 43, 71, 76, 80

getting started     9

glitch     50

glitches     28

graph     20, 31, 68, 84, 95

graphs     20

group     56, 104
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halt     59
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hanning     90

Harbour     81
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HAT     17, 24, 72
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Import     21, 37, 41, 80
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keys     27

- L -
land     104

LAT     17, 24, 72

latitude     76

layers     20, 23, 31

legend     23

level     17

Line     32
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load     21, 59

loading     13, 15, 21, 71

location     56, 63
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logs     94
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lunitidal     72
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manually     52

matrix     57

matrix inversion     57
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melting     88

menu     20
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meter     43

MHWN     17, 24, 72
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ML     17, 24, 72
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number     31
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operating     27

options     8

origin     20
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Overview     8
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Parameters     24
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plotting     20, 89

Point     20, 32
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port details     76

position     76

power     24, 84

power spectrum     18, 85

predict     20

predicted     56, 66, 71

predicting     10, 17, 20, 24
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printing     73

processor     70

Purpose     8
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- R -
raw     36

read     21

Readership     8

reading     21

readout     20

record     20, 56

records     31

reducing     48

regular     56, 67, 68, 70, 71

remove     15, 48

removing     28, 50

report     13, 17, 20, 24, 63, 70, 73

reporting     13, 70

resizing     30

resolution     87, 89
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running     9
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sample     22

sampling     10, 20, 48, 87

save     21, 63, 73

saving     13, 15, 21, 73

scale     20, 29, 84

scan     24, 84

scheme     13, 23, 56, 59, 86, 87, 96, 97

schemes     94, 104

Scope     8

screen     20
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searching data point     31

seasonal     88

selecting     48

setting     84

settings     21

shallow     61, 105

shortcut     27

sizing     30

smoothing     49

source     84

spectral     24, 84

spectrum     24, 84

speed     43, 44, 100

spikes     28
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standard     66, 107

Standard Deviation     24

Standard Error     24

starting     9

statistic     107
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stop     59

storm     106
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sufficient     56

sum     105

summer     88
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target     60
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Thickness     32
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tidal analysis     16

tidal parameters     17

tidal spectrum     18
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timescale     20
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trial and error     59
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user     27, 95
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window     90

windows     10
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word processor     17
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